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iMovie Lesson User Guide

This User Guide consists of two parts. The first part gives a web page address where all of the lesson materials, practice iMovie files, iMovie lessons, and an Instructional iMovie are located. The second part consists of a detailed guide that takes you through each lesson with pictures and steps to follow for creating an iMovie lesson.

Part One

http://homepage.mac.com/unagj78

This web address will take you to an introductory web page with three menu choices at the top of the page: iMovie Lesson Materials, iMovie Lessons and Practice iMovie Files. The iMovie Lesson materials may be used in conjunction with the iMovie Lesson User Guide. The Practice iMovie Files are used in lesson two. The lesson materials must be downloaded to a computer which has Adobe Acrobat Reader installed to open the downloaded files.  Adobe Acrobat Reader may be downloaded from the web page under the iMovie Lessons section if needed. 


The iMovie Lessons are the actual lesson plans for teaching how to create an instructional iMovie.  Each lesson plan gives specific objectives and steps for teachers to follow when teaching students to create an instructional iMovie. If you are the teacher you will want to download these plans as well as the iMovie Lesson Materials. If you are the student you will want to download the iMovie Lesson Materials and the iMovie Practice Files.. 
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Part Two
Lesson One

This lesson is an introductory lesson to introduce iMovie lessons. These are movies created for the purpose of teaching a concept or concepts to students. Teachers and students can easily create these movies. Teachers may create them to teach their core curriculum and students may create them to show understanding of concepts learned. Listed below are the web sites that show examples of iMovies created by teachers and students.

Apple’s iMovie Examples

http://www.springfield.k12.il.us/movie/list.html
Here you will find a list of iMovie examples. Choose any one of them to view an iMovie example.

Anti-Smoking iMovie

http://ali.apple.com/ali_sites/ali/exhibits/1000509
This iMovie example also includes a lesson plan. Just click on the word Play found in the iMovie example.

Leaf Classification iMovie

http://ali.apple.com/ali_sites/ali/exhibits/1000571/
This iMovie example also includes a lesson plan. Just click on the word Play found in the iMovie example.

This Old Habitat iMovie

http://ali.apple.com/ali_sites/ali/exhibits/1000736
This iMovie example also includes a lesson plan. Just click on the word Play found in the iMovie example.

Chasing Metaphors iMovie

http://ali.apple.com/ali_sites/ali/exhibits/1000881/
This iMovie example also includes a lesson plan. Just click on the word Play found in the iMovie example.
After viewing the iMovie examples, begin to formulate an idea for your own iMovie lesson and produce a storyboard that outlines the parts of your iMovie. A storyboard worksheet may be used or a computer program such as Inspiration may be used to illustrate the scenes for the iMovie. You will find a storyboard worksheet for download in the iMovie Lesson Materials section.

As you progress through this iMovie Lesson User Guide, you will put your own content (lesson plan) into your iMovie creation. The User Guide will provide you with the instruction and steps to complete an iMovie to use for instruction. Gather your own video clips, photos, and sounds to complete these lessons and in the end you will have a completed project.
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Lesson Two

The iMovie Workspace

This lesson contains the iMovie workspaces with the parts labeled and a web site with a practice movie clip and practice phtotos to download. The practice movie files may be used to practice using each function of the workspace except the import/edit which will be shown in lesson three and the audio parts which will be shown in lesson six.
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iMovie Lesson Two

Clip Shelf Workspace Diagram
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Lesson Two

Continued

Description of iMovie Workspace Parts

When you are in the iMovie program and you run the mouse over the workspace parts, you will see a description of that part.

Import/Edit – This tab must be on the import side to be able to bring in the video clips from a digital video camera.  When on the edit side, the iMovie can be created and edited.

Home – This button takes the movie clip back to the beginning.

Play – This button plays the movie clip in the workspace window.

Scrub Bar – The blue bar under the iMovie window which displays a timeline of selected video clips. The tick marks on the bar show the fractions of a second the clip plays.

Clip Shelf – The clip shelf is the space where each of the video clips and photos are stored.

Zoom Level – This button bar slides to expand or compress the view of the clips on the clip viewer. When the clips are expanded, it may be easier to see problems with audio and or transitions.

Crop Markers – The markers are used to edit a clip. Wherever the markers are placed, that part of the clip will be edited (split, cropped) in some way.

Clip Speed Change – Each clip may be slowed down (the turtle) or sped up (the rabbit).  When the clip is slowed down it goes in slow motion and so does the sound. When the clip is sped up it plays faster and may have a chipmunk sound effect.

Audio Track 1 – The second track on the clip viewer where audio files are placed when adding sound to your iMovie.

Audio Track 2 – The third track and second audio track on the clip viewer where audio files are placed when adding another sound (such as narration) to your iMovie.

Clip Viewer – The space where the clips are placed to build the iMovie.

Volume Control – Volume control for the whole iMovie.

Volume Control – This button bar slides to change the volume of the selected audio clip. The audio can be changed from soft to loud and vice versa throughout the iMovie. When the box to the left of the volume control is selected, clicking and dragging the volume line running through the audio track can manipulate the volume.  The box to the left of the volume control shows the percentage of the volume loudness from 0% to 150%.

Playhead – The triangular time marker that appears above the blue scrub bar at the top of the timeline view.  This marker slides left and right to view the iMovie or the selected iMovie clip from start to finish.

Disk Space – This indicates how much space is used on the hard drive of the computer.  Movies take up lots of space and this indicator helps you keep track of the hard drive space you’re using as you create iMovies.

Trash – When you don’t want a clip anymore, it can be dragged to the trash.  It is gone but not for good.

Audio Check Boxes – These boxes at the end of the timeline viewer tracks may be checked or unchecked to indicate whether or not you want the audio turned on or off in that track.

Blue Slider Bar – This bar under the timeline viewer tracks is used to slide through the movie clips on the clip viewer.

Import/Edit buttons – When the import side is selected the video clips may be imported from the video camera.  When the Edit button is selected your are ready to create and make changes to the iMovie.

Full Screen Mode – This button plays the movie in full screen mode.

Clips Button – Used to organize your video clips.

Photos Button – Used to import and edit photos.

Audio Button – Used to import and edit songs and sound effects.

Titles Button – Used to add titles and text to your iMovie.

Trans Button – Used to add transitions between our clips.

Effects Button – Used to add special effects to selected video clips.

IDVD Button – Used to add chapter markers and export to iDVD. (We will not be using this feature.)
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Lesson Two

Continued

Web site for downloading files to use in a practice iMovie.

http://homepage.mac.com/unagj78 

Click on the heading Practice iMovie Files
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Click Download to download each of the iMovie files for use in creating your own iMovie.

Wait for the files to download (usually to the desktop).
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Open iMovie and name the iMovie Practice. Then use the File menu to import each of the downloaded files from the desktop into the practice iMovie. Experiment with the iMovie program to become familiar with the look and feel of the program.
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Lesson Three

Importing scenes from the a digital video Camcorder into iMovie: 

a.  Connect your camcorder to your computer using a FireWire cable.  

b. Insert the tape with your video into the camcorder.  

Switch the camera to VCR mode. 

c. Make sure that the mode switch is set to camera mode as shown in the diagram.
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d. Use the iMovie camera controls to control the DV camcorder. 

e. Click the Play Button to start the DV camcorder.  

f. Click on the Import button to import the video to the computer.

g. Click on Import again to stop importing video.
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Lesson Four
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There are two ways to bring in photos or files from other sources.

A. Importing files to the Clip Viewer:  

a. Click on File.  

b. Click on Import. 

c. Locate and select the files you want to import.   

d. Click on Open
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B. Adding photos:

a.    Click on the Photos button below the 


Clip Shelf.


b.     Select the photo from the Photo 


Library or Last Import menu.

c.     Check the Ken Burns Effect if wanted.

d.     Adjust the Duration and/or Zoom.

e.     Drag the photo to the Clip Viewer.

f.      Place in the appropriate place.
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To use the Ken Burns Effect, be sure to click the Ken Burns Effect check box. You can choose the start and end place for this effect by placing the mouse in the preview window and move the picture to the start and end spots.  First preview your work and then click Apply.

3. Moving video clips to the Clip Viewer:  

a. Click on the clip that you want to move to the Viewer.  

b. Drag the clip to the Clip Viewer.  

c. Repeat this step with other clips.  

Note:  The same steps above are also used to move other file types (still images etc.) to the Clip Viewer.
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Lesson Five

     
Managing clips:
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a.  To crop a clip: 

1.  Click on the clip in the Clip Viewer to be cropped.

2.  Click below the scrub bar and drag the crop markers to the beginning and end frames desired.

3. Choose Crop in the Edit menu.

b.  To split a clip:

1.  Click on the clip to be split.

2.  Use the scrub bar to move the Playhead to the frame for the desired split.

3. Choose Split Video Clip at Playhead in the edit menu.

c.  To reverse clip direction:

1.  Click on the clip to be reversed.

2. Choose Reverse Clip Direction from the Advanced menu.

d.  To create a still clip:

1.  Click on the clip to be made still.

2. Place the Playhead at the place where the still clip shows.


3.  Choose Create Still Frame from the Edit menu.

e. To change a clip’s title:

            1.  Make sure the Clip view is on regular view not timeline view.

2.  Click on the title underneath the clip in the clip shelf. 



3.  Highlight the title that shows.



4.  Type over the new title.
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Lesson Six

  
Adding Audio to your iMovie:  

Click on the Audio button below the Clip Shelf.
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Lesson Six

Continued
After the audio clip is added to the audio track, you can edit the volume by putting a check mark in the Edit volume box.



You can set the volume to the loudness you want throughout the whole movie or you can change the volume up and down through out the movie.
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Putting a check mark in the Edit volume box also places a line through the audio track. You can click on the line and drag the line up or down to increase or decrease the volume at any spot in the movie.



These audio check boxes may be checked or unchecked to determine which tracks will 



be used in your iMovie.










You may extract the audio from the 








video clip by choosing Extract Audio









from the Advanced menu.


Lesson Seven

 
 Adding a Title Clip to your iMovie:  


a. Click on the Titles Button below the Clip Shelf.  

b. Select a style from the list and type the text you want in the editing fields.

c.
Make changes to the Title using the following Title Editing Tools (see diagram) 

d.
Drag the title to the Clip Viewer. 













Lesson Seven 

Continued

Adding transitions to your iMovie:  

a. Click on the Transitions Button below the Clip Shelf.  


b. Select a transition from the list. 

c. Drag the transition to the Clip Viewer placing the transition between the two clips where you want the transition to take effect.

Note: There must be enough space in the clips to add a transition because transitions take up some the their time from the clip.

Adding Effects to your iMovie:  

a. Click on the Effects Button below the Clip Shelf. 



b. Select an Effect from the list.  

c. Adjust the Effect In and the Effect Out.

d. Click on the Preview button to see what the effect looks like.

e. Click on Apply to apply the effect to the selected clip.


Lesson Eight


Exporting the finished iMovie:

a. Click on File then click on Share.

b. Select Email, HomePage, 

c. Videocamera, iDVD, Quicktime, 

d. or Bluetooth. 

e. Click on Share.

For our lessons we will use either 

QuickTime or Videocamera.

Note:If you choose Videocamera your

camera must be connected to 

the computer with the Firewire Cable.

When you are ready, click Share.
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These are prepackaged sounds. Simply select a sound and drag it to the audio track.





To record your voice or another sound, click the Record Audio Button and talk into the internal microphone, or use a microphone that is plugged into your computer. 





To record from a CD:


Insert the CD.


Select the track.


Set the Playhead at the point you want the music to begin.


Drag and drop the music file to the clip viewer. 








Note: You must decide which format to use when you export to QuickTime.  (Your file size gets larger as you go down the list.)


CD-ROM is best for most uses.  








Crop Markers





Audio Clip





















































